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Chapter 171 

Non-Inferiority Tests 
for the Odds Ratio of 
Two Proportions in a 
2x2 Cross-Over 
Design 
Introduction 
Senn (2002) defines a cross-over design as one in which each subject receives all treatments and the objective is 
to study differences among the treatments. The name cross-over comes from the most common case in which 
there are only two treatments. In this case, each subject crosses over from one treatment to the other. It is assumed 
that there is a washout period between treatments during which the response returns back to its baseline value. If 
this does not occur, there is said to be a carry-over effect.  

A 2×2 cross-over design contains to two sequences (treatment orderings) and two time periods (occasions). One 
sequence receives treatment A followed by treatment B. The other sequence receives B and then A. The design 
includes a washout period between responses to make certain that the effects of the first drug do not carry over to 
the second. Thus, the groups in this design are defined by the sequence in which the drugs are administered, not 
by the treatments they receive. Indeed, higher-order cross-over designs have been used in which the same 
treatment is used at both occasions. 

Cross-over designs are employed because, if the no-carryover assumption is met, treatment differences are 
measured within a subject rather than between subjects—making a more precise measurement. Examples of the 
situations that might use a cross-over design are the comparison of anti-inflammatory drugs in arthritis and the 
comparison of hypotensive agents in essential hypertension. In both cases, symptoms are expected to return to 
their usual baseline level shortly after the treatment is stopped. 

The sample size calculations in the procedure are based on the formulas presented in Lui (2016). 

Advantages of Cross-Over Designs 
A comparison of treatments on the same subject is expected to be more precise. The increased precision often 
translates into a smaller sample size. Also, patient enrollment into the study may be easier because each patient 
will receive both treatments. Finally, it is often more difficult to obtain a subject than to obtain a measurement. 
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Disadvantages of Cross-Over Designs 
The statistical analysis of a cross-over experiment is more complex than a parallel-group experiment and requires 
additional assumptions. It may be difficult to separate the treatment effect from the period effect, the carry-over 
effect of the previous treatment, and the interaction between period and treatment. 

The design cannot be used when the treatment (or the measurement of the response) alters the subject 
permanently. Hence, it should not be used to compare treatments that are intended to provide a cure. 

Because subjects must be measured at least twice, it is often more difficult to keep patients enrolled in the study. 
It is arguably simpler to measure a subject once than to obtain their measurement twice. This is particularly true 
when the measurement process is painful, uncomfortable, embarrassing, or time consuming. 

Technical Details 
The 2×2 crossover design may be described as follows. Randomly assign the subjects to one of two sequence 
groups so that there are 𝑛𝑛1 subjects in sequence one and 𝑛𝑛2 subjects in sequence two. In order to achieve design 
balance, the sample sizes 𝑛𝑛1 and 𝑛𝑛2  are assumed to be equal so that 𝑛𝑛1 = 𝑛𝑛2 = 𝑛𝑛 = 𝑁𝑁/2. 

Sequence one is given the control (A) followed by the treatment (B). Sequence two is given the treatment (B) 
followed by the control (A).  

The design can be analyzed using a simple z-test if we ignore period and sequence effects or using a more 
complex random effects logistic regression model that adjusts for period and sequence effects. The sample size 
calculations herein ignore period and sequence effects. Julious (2010) suggests on page 175 that the bias due to 
ignoring period effects if a period-adjusted analysis is planned is not great and that sample size calculations that 
ignore period effects are adequate.  

Cross-Over Design 
The discussions that follow summarize the results in Lui (2016). Consider a 2×2 cross-over design and let  
𝑥𝑥𝑖𝑖𝑖𝑖

(𝑔𝑔) represent the binary response (0 or 1) from the jth subject, j = 1, …, ng, in the ith period (i = 1, 2), in sequence 

g (g = 1, 2). Let 𝑛𝑛𝑟𝑟𝑟𝑟
(𝑔𝑔) represent the number of subjects among 𝑛𝑛𝑔𝑔 subjects in sequence g with the response vector 

(x1j = r, x2j = c). We can then summarize the results in terms of counts from a cross-over design with the following 
table for sequences 1 and 2 as 

  
 

 

SEQUENCE 1 (Control → Treatment) 

  Period 2 
(Treatment) 

  Yes No Total 

Period 1 
(Control) 

Yes 𝑛𝑛11
(1) 𝑛𝑛10

(1) 𝑛𝑛1∙
(1) 

No 𝑛𝑛01
(1) 𝑛𝑛00

(1) 𝑛𝑛0∙
(1) 

 Total 𝑛𝑛∙1
(1) 𝑛𝑛∙0

(1) 𝑛𝑛1 

 

SEQUENCE 2 (Treatment → Control) 

  Period 2 
(Control) 

  Yes No Total 

Period 1 
(Treatment) 

Yes 𝑛𝑛11
(2) 𝑛𝑛10

(2) 𝑛𝑛1∙
(2) 

No 𝑛𝑛01
(2) 𝑛𝑛00

(2) 𝑛𝑛0∙
(2) 

 Total 𝑛𝑛∙1
(2) 𝑛𝑛∙0

(2) 𝑛𝑛2 
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In terms of proportions, the 2×2 cross-over design tables can be summarized as 

  
with the individual proportions estimated as 

𝑃𝑃�𝑟𝑟𝑟𝑟
(𝑔𝑔) =

𝑛𝑛𝑟𝑟𝑟𝑟
(𝑔𝑔)

𝑛𝑛𝑔𝑔
. 

Lui (2016) indicates on pages 32-42 that the odds ratio for the treatment versus the control (𝑂𝑂𝑇𝑇/𝑂𝑂𝐶𝐶) is defined for 
a 2×2 cross-over design as 

𝑂𝑂𝑂𝑂 = �
𝑃𝑃01

(1)𝑃𝑃10
(2)

𝑃𝑃10
(1)𝑃𝑃01

(2) 

with estimate 

𝑂𝑂𝑂𝑂� = �
𝑃𝑃�01

(1)𝑃𝑃�10
(2)

𝑃𝑃�10
(1)𝑃𝑃�01

(2). 

The estimated log odds ratio, log�𝑂𝑂𝑂𝑂� �, has asymptotic variance 𝜎𝜎2 𝑛𝑛⁄  with 

𝜎𝜎2 =
1
4
�

1

𝑃𝑃01
(1) +

1

𝑃𝑃10
(1) +

1

𝑃𝑃01
(2) +

1

𝑃𝑃10
(2)� 

which can be estimated as 

𝜎𝜎�2 =
1
4
�

1

𝑃𝑃�01
(1) +

1

𝑃𝑃�10
(1) +

1

𝑃𝑃�01
(2) +

1

𝑃𝑃�10
(2)�. 

The standard deviation, then, is 

𝑆𝑆𝑆𝑆 =  𝜎𝜎 = �𝜎𝜎2 

with estimate 

𝑆𝑆𝑆𝑆� =  𝜎𝜎� = �𝜎𝜎�2. 

  

SEQUENCE 1 (Control → Treatment) 

  Period 2 
(Treatment) 

  Yes No Total 

Period 1 
(Control) 

Yes 𝑃𝑃11
(1) 𝑃𝑃10

(1) 𝑃𝑃1∙
(1) 

No 𝑃𝑃01
(1) 𝑃𝑃00

(1) 𝑃𝑃0∙
(1) 

 Total 𝑃𝑃∙1
(1) 𝑃𝑃∙0

(1) 1 

 

SEQUENCE 2 (Treatment → Control) 

  Period 2 
(Control) 

  Yes No Total 

Period 1 
(Treatment) 

Yes 𝑃𝑃11
(2) 𝑃𝑃10

(2) 𝑃𝑃1∙
(2) 

No 𝑃𝑃01
(2) 𝑃𝑃00

(2) 𝑃𝑃0∙
(2) 

 Total 𝑃𝑃∙1
(2) 𝑃𝑃∙0

(2) 1 
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Non-Inferiority Test Statistics 

Higher Proportions Better 
When higher proportions are better, the null and alternative hypotheses for a one-sided non-inferiority test are 

𝐻𝐻0:𝑂𝑂𝑂𝑂 ≤ 𝑂𝑂𝑂𝑂0  vs   𝐻𝐻𝐴𝐴:𝑂𝑂𝑂𝑂 > 𝑂𝑂𝑂𝑂0 

where 𝑂𝑂𝑂𝑂0 is the lower non-inferiority bound (i.e. the smallest odds ratio (Ot/Oc) for which the treatment will still 
be considered non-inferior to the standard or control). When higher proportions are better, 𝑂𝑂𝑂𝑂0 should be less 
than one. 

The power and sample size calculations are based on the test statistic  

𝑍𝑍 =
log�𝑂𝑂𝑂𝑂� � − log(𝑂𝑂𝑂𝑂0)

𝑆𝑆𝑆𝑆�
√𝑛𝑛

 

which is asymptotically distributed as standard normal under the null hypothesis. The null hypothesis is rejected 
in favor of the alternative at level 𝛼𝛼 if  

log�𝑂𝑂𝑂𝑂� � − log(𝑂𝑂𝑂𝑂0)
𝑆𝑆𝑆𝑆�
√𝑛𝑛

> 𝑍𝑍1−𝛼𝛼 

where 𝑍𝑍1−𝛼𝛼 is the upper 1 − 𝛼𝛼 percentile of the standard normal distribution. 

Higher Proportions Worse 
When higher proportions are worse, the null and alternative hypotheses for a one-sided non-inferiority test are 

𝐻𝐻0:𝑂𝑂𝑂𝑂 ≥ 𝑂𝑂𝑂𝑂0  vs   𝐻𝐻𝐴𝐴:𝑂𝑂𝑂𝑂 < 𝑂𝑂𝑂𝑂0 

where 𝑂𝑂𝑂𝑂0 is the upper non-inferiority bound (i.e. the largest odds ratio (Ot/Oc) for which the treatment will still 
be considered non-inferior to the standard or control). When higher proportions are worse, 𝑂𝑂𝑂𝑂0 should be greater 
than one. 

The power and sample size calculations are based on the test statistic  

𝑍𝑍 =
log�𝑂𝑂𝑂𝑂� � − log(𝑂𝑂𝑂𝑂0)

𝑆𝑆𝑆𝑆�
√𝑛𝑛

 

which is asymptotically distributed as standard normal under the null hypothesis. The null hypothesis is rejected 
in favor of the alternative at level 𝛼𝛼 if  

log�𝑂𝑂𝑂𝑂� �− log(𝑂𝑂𝑂𝑂0)
𝑆𝑆𝑆𝑆�
√𝑛𝑛

< 𝑍𝑍𝛼𝛼 

where 𝑍𝑍𝛼𝛼 is the lower 𝛼𝛼 percentile of the standard normal distribution. 
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Non-Inferiority Power Calculations 

Higher Proportions Better 
Derived from the sample size formula given in Lui (2016) on pages 42 and 43, the power for the one-sided non-
inferiority test of 𝐻𝐻0:𝑂𝑂𝑂𝑂 ≤ 𝑂𝑂𝑂𝑂0 versus 𝐻𝐻𝐴𝐴:𝑂𝑂𝑂𝑂 > 𝑂𝑂𝑂𝑂0 is  

Φ�
log(𝑂𝑂𝑂𝑂1)− log(𝑂𝑂𝑂𝑂0)

𝑆𝑆𝑆𝑆
√𝑛𝑛

− 𝑍𝑍1−𝛼𝛼� 

where Φ() is the standard normal distribution function, 𝑂𝑂𝑂𝑂1 is the actual value of the odds ratio under the 
alternative hypothesis, and 𝑍𝑍1−𝛼𝛼 is the upper 1 − 𝛼𝛼 percentile of the standard normal distribution. The sample size 
calculation formula is 

𝑛𝑛 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 ��
�𝑍𝑍1−𝛼𝛼 + 𝑍𝑍1−𝛽𝛽�𝑆𝑆𝑆𝑆

log(𝑂𝑂𝑂𝑂1)− log(𝑂𝑂𝑂𝑂0)�
2

�. 

Higher Proportions Worse 
Derived from the sample size formula given in Lui (2016) on pages 42 and 43, the power for the one-sided non-
inferiority test of 𝐻𝐻0:𝑂𝑂𝑂𝑂 ≥ 𝑂𝑂𝑂𝑂0 versus 𝐻𝐻𝐴𝐴:𝑂𝑂𝑂𝑂 < 𝑂𝑂𝑂𝑂0 is  

Φ�
log(𝑂𝑂𝑂𝑂0)− log(𝑂𝑂𝑂𝑂1)

𝑆𝑆𝑆𝑆
√𝑛𝑛

+ 𝑍𝑍𝛼𝛼� 

where Φ() is the standard normal distribution function, 𝑂𝑂𝑂𝑂1 is the actual value of the odds ratio under the 
alternative hypothesis, and 𝑍𝑍𝛼𝛼 is the lower 𝛼𝛼 percentile of the standard normal distribution. The sample size 
calculation formula is 

𝑛𝑛 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 ��
�𝑍𝑍1−𝛼𝛼 + 𝑍𝑍1−𝛽𝛽�𝑆𝑆𝑆𝑆

log(𝑂𝑂𝑂𝑂0)− log(𝑂𝑂𝑂𝑂1)�
2

�. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
This option specifies the parameter to be calculated from the values of the other parameters. Under most 
conditions, you would select either Power or Sample Size. 

Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha level.  

Select Power when you want to calculate the power of an experiment that has already been run.  

Select Effect Size (OR1) when you want to calculate the minimum effect size that can be detected for a particular 
design.  

Test 

Higher Proportions Are 
Use this option to specify the direction of the test. 

If Higher Proportions are “Better”, the alternative hypothesis is H1: OR > OR0. 

If Higher Proportions are “Worse”, the alternative hypothesis is H1: OR < OR0. 

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of 
equal means when in fact the means are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal 
means when in fact the means are equal.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  
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Sample Size 

n (Sample Size per Sequence) 
This is the sample size of each sequence or group (AB and BA) in the cross-over design. The individual sequence 
sample sizes are assumed to be equal such that the total sample size is equal to N = 2n.  

You can enter a single value such as 50 or a list of values using the syntax 50 100 150 200 250 or 50 to 250 by 50.  

Effect Size – Odds Ratio 

OR0 (Non-Inferiority Odds Ratio) 
Specify the non-inferiority odds ratio. 

When higher proportions are “Better”, the non-inferiority odds ratio is the smallest odds ratio (Ot/Oc) for which 
the treatment will still be considered non-inferior to the standard or control.  

When higher proportions are “Worse”, the non-inferiority odds ratio is the largest odds ratio (Ot/Oc) for which 
the treatment will still be considered non-inferior to the standard or control.  

You can enter a single value such as 0.8 or a series of values such as 0.8 0.85 0.9 or 0.8 to 0.9 by 0.05 in the range 
OR0 > 0, OR0 ≠ OR1. When higher proportions are “Better”, OR0 should be less than one. When higher 
proportions are “Worse”, OR0 should be greater than one. 

OR1 (Actual Odds Ratio) 
Specify the actual odds ratio at which power is calculated. 

The odds ratio is the ratio of the odds of the treatment group showing a response to the odds of the control group 
showing a response. 

OR1 = Ot/Oc = [Pt/(1-Pt)] / [Pc/(1-Pc)] or √[P01(1)P10(2) / P10(1)P01(2)] 

For example, an odds ratio of 2 means that the odds of a response in the treatment group is twice the odds of a 
positive response in the control group. 

You can enter a single value such as 1 or a series of values such as 1 1.5 2 or 1 to 2 by 0.5 in the range OR1 > 0, 
OR1 ≠ OR0. When higher proportions are “Better”, OR1 should be greater than OR0. When higher proportions 
are “Worse”, OR1 should be less than OR0. 

Effect Size – Standard Deviation of Log(Odds 
Ratio) 

Standard Deviation Estimation Method 
Choose how the standard deviation of the log odds ratio (SD) will be estimated. 

The options are 

• Enter SD Directly 
Input log odds ratio SD values directly. This option allows you to input any value for SD, regardless of how it 
was estimated. 

• Use Estimated Discordant Cell Proportions 
Input discordant cell proportions from 2 tables from a previous 2x2 cross-over study. This is the method 
described in Lui (2016). These estimates are used only to calculate the standard deviation and are not 
necessarily related to the value used for OR1. 
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Standard Deviation (SD) 
Enter a value for the standard deviation of the log odds ratio, SD. 

Estimating SD using Previously-Estimated Discordant Cell Proportions 
The standard deviation may be estimated using discordant cell proportions from a previous study using the 
method of Lui (2016) on page 42, where 

SD = √[(1/4)*(1/p01(1) + 1/p10(1) + 1/p01(2) + 1/p10(2))]. 

PASS will calculate the SD for you using this method if you set Estimation Method to “Use Estimated Discordant 
Cell Proportions” and enter discordant cell proportions from 2 tables from a previous 2x2 cross-over study. 

Discordant Cell Proportions 
Enter the corresponding discordant cell proportion from a previous 2x2 cross-over study. 

The estimated proportions are defined as follows: 

 

SEQUENCE 1 (C→T) 

p01(1): Control = “No”, Treatment = “Yes” 

p10(1): Control = “Yes”, Treatment = “No” 

 

SEQUENCE 2 (T→C) 

p01(2): Control = “Yes”, Treatment = “No” 

p10(2): Control = “No”, Treatment = “Yes” 

 

The standard deviation is calculated by PASS as described in Lui (2016) on page 42 as 

SD = √[(1/4)*(1/p01(1) + 1/p10(1) + 1/p01(2) + 1/p10(2))]. 

These estimates are used only to calculate the standard deviation and are not necessarily related to the value used 
for OR1. 

Range: 0 < p01(g) < 1, 0 < p10(g) < 1, p01(g) + p10(g) ≤ 1  

http://www.ncss.com/


PASS Sample Size Software NCSS.com   
Non-Inferiority Tests for the Odds Ratio of Two Proportions in a 2x2 Cross-Over Design 

171-9 
 © NCSS, LLC. All Rights Reserved. 

Example 1 – Power Analysis 
Suppose you want to consider the power of a non-inferiority test of the hypotheses 𝐻𝐻0:𝑂𝑂𝑂𝑂 ≤ 0.8 versus 𝐻𝐻𝐴𝐴:𝑂𝑂𝑂𝑂 >
0.8 in a balanced cross-over design with a binary endpoint where the test is computed based on the odds ratio for 
sample sizes between 25 and 125. Let’s assume that the actual odds ratio is 2 and the estimated standard deviation 
of the log odds ratio is 2.5. The significance level is 0.05.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Inferiority Tests for the Odds Ratio of Two Proportions in a 2x2 Cross-Over Design 
procedure window by expanding Proportions, then Cross-Over (2x2) Design, then clicking on Non-Inferiority, 
and then clicking on Non-Inferiority Tests for the Odds Ratio of Two Proportions in a 2x2 Cross-Over 
Design. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu 
and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Higher Proportions Are ........................... Better 
Alpha ....................................................... 0.05 
n (Sample Size per Sequence) ............... 25 to 125 by 25 
OR0 (Non-Inferiority Odds Ratio) ........... 0.8 
OR1 (Actual Odds Ratio) ........................ 2 
Estimation Method .................................. Enter SD Directly 
Standard Deviation (SD) ......................... 2.5 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for a Non-Inferiority Test ─────────────────────────────────────────── 
H0: OR ≤ OR0 vs. H1: OR > OR0 
 
 Sequence Total Non-Inf. Actual   
 Sample Sample Odds Odds Standard  
 Size Size Ratio Ratio Deviation  
Power n N OR0 OR1 SD Alpha 
0.57445 25 50 0.800 2.000 2.500 0.050 
0.82813 50 100 0.800 2.000 2.500 0.050 
0.93690 75 150 0.800 2.000 2.500 0.050 
0.97832 100 200 0.800 2.000 2.500 0.050 
0.99291 125 250 0.800 2.000 2.500 0.050 
 
References  
Lui, Kung-Jong. 2016. Crossover Designs: Testing, Estimation, and Sample Size. John Wiley & Sons Ltd. 
   Chichester, West Sussex, England. 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
n is the sample size in each sequence (or group). 
N is the total combined sample size from both sequences. 
OR0 is the non-inferiority odds ratio used to specify the hypothesis test. 
OR1 is the actual odds ratio at which power is calculated. 
SD is the user-entered standard deviation. This is estimated from a previous study. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
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Summary Statements ───────────────────────────────────────────────────────── 
For a 2x2 cross-over design, a sample size of 25 in each sequence for a total of 50 achieves 
57.445% power to detect an odds ratio of 2.000 using a one-sided non-inferiority test against a 
bound of 0.800 with a significance level of 0.050 when the standard deviation is 2.500. 
 
 
Dropout-Inflated Sample Size ──────────────────────────────────────────────────── 
 
  Dropout-Inflated Expected 
  Enrollment Number of 
 ── Sample Size ── ── Sample Size ── ── Dropouts ── 
Dropout Rate n N n' N' d D 
20% 25 50 32 64 7 14 
20% 50 100 63 126 13 26 
20% 75 150 94 188 19 38 
20% 100 200 125 250 25 50 
20% 125 250 157 314 32 64 
 
Definitions 
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the 
   course of the study and for whom no response data will be collected (i.e. will be treated as “missing”). 
n and N are the evaluable group and total sample sizes, respectively, at which power is computed (as entered 
   by the user). If n subjects from each group are evaluated out of the n' subjects that are enrolled in the 
   study, the design will achieve the stated power. N = 2n. 
n' and N' are the number of subjects that should be enrolled in the study in order to end up with n and N 
   evaluable subjects, based on the assumed dropout rate. n' is calculated by inflating n using the formula n' 
   = n / (1 - DR), with n' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., Shao, J., 
   and Wang, H. (2008) pages 39-40.). N' = 2n'. 
d and D are the expected number of group and total dropouts, respectively. d = n' - n and D = 2d. 
 

Charts Section 
 

 
 

This report shows the values of each of the parameters, one scenario per row. This plot shows the relationship 
between sample size and power. We see that a sample size of just under 50 per sequence is required to detect an 
odds ratio of 2 with 80% power. 
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Example 2 – Calculating Sample Size when Estimating the 
Standard Deviation from a Previous Study (Validation using Lui 
(2016)) 
This example demonstrates how to calculate the sample size when estimating the standard deviation of the log 
odds ratio from data in a previous study using the method in Lui (2016) on page 42. In this example we’ll find the 
sample size required to detect an odds ratio of 2 with 80% power at a significance level of 0.05 in a non-
inferiority test against a lower odds ratio bound of 0.8. The SD is estimated from discordant proportions in a 
previous study. 

Table 3.2 of Lui (2016) on page 36 presents the results below from 279 subjects a simple 2x2 cross-over trial 
comparing two inhalation devices, A and B. Lui (2016) presents this sample size calculation in Example 3.5 on 
page 43 and finds a required sample size of 48 subjects per sequence. 

  
The discordant proportions are estimated as 

𝑃𝑃�01
(1) =

15
139

= 0.1079 

𝑃𝑃�10
(1) =

41
139

= 0.2950 

𝑃𝑃�01
(2) =

32
140

= 0.2286 

𝑃𝑃�10
(2) =

16
140

= 0.1143 

Using the method of Lui (2016) on page 42, SD is estimated as 

𝑆𝑆𝑆𝑆� = �𝜎𝜎�2 

= �
1
4
�

1

𝑃𝑃�01
(1) +

1

𝑃𝑃�10
(1) +

1

𝑃𝑃�01
(2) +

1

𝑃𝑃�10
(2)� 

= �1
4
�

1
0.1079

+
1

0.2950
+

1
0.2286

+
1

0.1143
� 

= 𝟐𝟐.𝟓𝟓𝟓𝟓𝟓𝟓𝟓𝟓 

PASS will calculate this SD value for you automatically when you input the discordant cell proportions. 

SEQUENCE 1 (Control (A) → Treatment (B)) 

  Period 2 
(B) 

  Yes No Total 

Period 1 
(A) 

Yes 26 41 67 

No 15 57 72 

 Total 41 98 139 

 

SEQUENCE 2 (Treatment (B) → Control (A)) 

  Period 2 
(A) 

  Yes No Total 

Period 1 
(B) 

Yes 38 16 54 

No 32 54 86 

 Total 70 70 140 
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Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Inferiority Tests for the Odds Ratio of Two Proportions in a 2x2 Cross-Over Design 
procedure window by expanding Proportions, then Cross-Over (2x2) Design, then clicking on Non-Inferiority, 
and then clicking on Non-Inferiority Tests for the Odds Ratio of Two Proportions in a 2x2 Cross-Over 
Design. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu 
and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Higher Proportions Are ........................... Better 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
OR0 (Non-Inferiority Odds Ratio) ........... 0.8 
OR1 (Actual Odds Ratio) ........................ 2 
Estimation Method .................................. Use Estimated Discordant Cell Proportions 
p01(1) ..................................................... 0.1079 
p10(1) ..................................................... 0.2950 
p01(2) ..................................................... 0.2286 
p10(2) ..................................................... 0.1143 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for a Non-Inferiority Test ─────────────────────────────────────────── 
H0: OR ≤ OR0 vs. H1: OR > OR0 
 
 Sequence Total Non-Inf. Actual   
 Sample Sample Odds Odds Standard  
 Size Size Ratio Ratio Deviation  
Power n N OR0 OR1 SD* Alpha 
0.80391 48 96 0.800 2.000 2.539 0.050 
 
* SD Estimated using Previously-Estimated Discordant Cell Proportions: 
  p01(1) = 0.1079, p10(1) = 0.295, p01(2) = 0.2286, p10(2) = 0.1143 
 

This report indicates that the estimated standard deviation using the method of Lui (2016) is 2.539 and the 
required sample size is 48 per sequence, which matches the published result in Lui (2016) exactly. The discordant 
cell proportions are also listed. The calculated value for SD matches our hand calculations above. 
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